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1. Product name
Adobe® Acrobat® 8 for Citrix Presentation ServerTM

2. Document overview
This document explains how an IT manager can host Adobe Acrobat on a server and 
have it emulated on Microsoft® Windows® client computers that use Citrix Presentation 
Server. This document assumes that you have a basic understanding of the Windows 
operating system, Citrix Presentation Server, and Adobe Acrobat.

This document also provides information on common troubleshooting issues.

3. References
	Adobe Developer Center  
http://www.adobe.com/devnet/acrobat/

	Adobe documentation about enterprise deployment 
http://www.adobe.com/devnet/acrobat/enterprise_deployment.html

	Acrobat IT Solutions Web site on Adobe Acrobat products targeted to the IT professional 
http://www.adobe.com/products/acrobat/solutions/it/index.html

	Citrix Presentation Server home page 
http://www.citrix.com/site/PS/products/product.asp?familyID=198&productID=186

	Adobe TechNote: Extract the Adobe Reader 8 msi installer for enterprise deployment 
http://www.adobe.com/go/kb400540 

4. Product overview
Adobe has validated the remote application execution of Acrobat 8 Professional, 
Acrobat 8 Standard, Acrobat 3D, and Adobe Reader® 8 by using Citrix Presentation 
Server 4.0, Enterprise Edition.

4.1 System requirements
You can find the system requirements for Acrobat 8 products at the following locations:

	Acrobat 3D: 
http://www.adobe.com/products/acrobat3d/productinfo/systemreqs/

	Acrobat 8 Professional:  
http://www.adobe.com/products/acrobatpro/productinfo/systemreqs/

	Acrobat 8 Standard:  
http://www.adobe.com/products/acrobatpro/acrobatstd.html?tab:systemreqs=1

	Acrobat 8 Reader: 
http://www.adobe.com/products/acrobat/acrrsystemreqs.html#80win

4.2  Tested environments
Acrobat 8 has been tested in the following Citrix environment:

	Citrix Presentation Server 4.0 on Windows Server 2003 Enterprise Edition with 
Service Pack 1 (SP1).
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The environments used for validation were set up in the following ways:

	A user account was set up using Active Directory domain user group.

	 Note  The Anonymous User profile was not tested.

	The user account was set up on the server with a restricted Common User profile, with Read, 
Read and Execute, and List Folder Contents permissions. These permissions enable the user 
to operate the computer and save documents; they do not allow the user to install programs 
or make changes to the system files or settings.

	The server machine was running Microsoft Office Professional Edition 2003 with Service 
Pack 2, Microsoft Internet Explorer® 6.0, Microsoft Visio® Professional Version 2003, Microsoft 
Office Publisher 2003, Microsoft Office Project Professional 2003, Lotus Notes® 7.0, and 
McAfee® VirusScan Enterprise 8.0.

5. Installing and configuring Acrobat 8 products 
You must install Acrobat 8 products by using either Add or Remove Programs or Citrix 
Installation Manager on the computer running Citrix Presentation Server.

Note  For more information about how to use Citrix Installation Manager, see  
Installation_Manager_Guide.pdf, which is installed by default with the Citrix Presentation  
Server in Program Files\Citrix\Documentation\docs.

To install Acrobat 8 products using Add or Remove Programs:

1.	  Click Start, click Settings, click Control Panel, and then click Add or Remove Programs.

2.	Click Install.

3.	Do one of the following:

	If you are installing from a CD, insert the disk, and then click Next.

	If you are installing from an executable file on the network, click Next, and then click 
Browse to locate the file. 

4.	Click Finish.

	 Note  After installing Acrobat 8 products, the Acrobat installer may prompt you to restart  
	 the server. If you receive this prompt, it is strongly recommended that you restart the system.

5.1  Publishing the application on the server
Before clients can access an application, you must publish it on the server by using the Citrix 
Management Console.

To publish an application:

1.	Click Start, point to All Programs, point to Citrix, and then click Citrix Management Console.

2.	In the Log On to Citrix Farm dialog box, select the server you want to publish to, and then 
type your Citrix Administrator credentials.

3.	In the Citrix Management Console dialog box, expand the Applications tree.

4.	Right-click Application, and then click Publish Application.

5.	On the first page of the Application Publishing Wizard, type a display name (for example, 
Acrobat) and a description of the application (for example, PDF Creation) that you want to 
appear on the Web interface and other client interfaces, and then click Next.

6.	On the next page, click Application, and then click Browse to select the application you want 
to publish (for example, Acrobat.exe). Then, click Next.

7.	 On the Program Neighborhood Settings page, click Next.

8.	On the Specify Application Appearance page, make any changes to the application resolution, 
and then click Next.

9.	On the next page, if you want to enable audio, click Enable Audio. Then, click Next.
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10.	On the Specify Application Limits page, click Next.

11.	On the Specify Servers page, in the list, click Citrix Server, and then click Add to move it to 
the Configured Servers list. Then, click Next.

12.	On the Specify Users page, if you want to specify users who can run the application, clear 
the Allow Anonymous Connections option, and specify the users you want to allow. Then, 
click Next.

13.	On the Specify File Type Associations page, click Finish.

14.	The wizard finishes and the application is published.

5.2  Activating Acrobat
You must activate Acrobat online after installing it on the server. If the product is not activated, 
it will time out and will not function after 30 days. You can activate Acrobat in one of two ways:

Upon launching Acrobat for the first time, you will be prompted to activate the product. 
Complete the process at this time and no further prompts will be shown to the administrator 
or end user.

	 or

Licensing customers can customize the activation process in a number of ways to fit their 
working environment. For more information, please see: 
http://www.adobe.com/elicensing/licensemanagement/alm.

5.3  Basic acceptance tests for Acrobat
After the installation is complete, you should test the application on a target computer. This sec-
tion details the tests you can perform to ensure that you installed Acrobat successfully.

To verify that the Acrobat plug-ins have been loaded:

1.	Start Acrobat, and then verify that no error messages appear on the startup screen.

2.	On the Help menu, click About Adobe Acrobat Plug-ins.

3.	Select each plug-in listed in the left column; then verify that Yes appears for the Loaded status 
located on the right under File Name.

To check that basic file commands are working correctly:

Open one or more files, and then do the following: 

1.	Page through the files by using the up and down arrows.

2.	Print the files to a printer on the network.

3.	On the File menu, click Save As to save the files with or without changes.

4.	Select Document, and then click Insert Pages. Insert another file into the document, save the 
file, and then close the file. Reopen the file and verify that the document contains the inserted 
pages.

To check menu items:

Select the menu item you want to check, and then do the following: 

If a dialog box appears, close it. 

If a document opens, close it. 

If a Web page opens, close it.

Repeat steps for each menu item you want to check.
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To create a test PDF file:

1.	Start Acrobat.

2.	On the File menu, click Create PDF, and then click From File.

3.	In the Open dialog box, browse to any Office Word, Excel, or PowerPoint file, and then 
click Open.

4.	Verify that a PDF file was created. For example, check file properties to verify that file size is 
greater than zero, or open the file.

To verify viewing a PDF file in a browser:

In Internet Explorer, go to http://www.adobe.com/products/acrobat/pdfs/pdfaccess.pdf.

5.4  Using Acrobat on client computers
After Acrobat 8 is published on the server (see section 5.1 “Publishing the application on the 
server”), Citrix client computers can establish connections to it.

To add a new connection:

1.	Click Start, point to All Programs, then point to Citrix ICA Client, and then click Citrix 
Program Neighborhood.

2.	Select Add New ICA Connection to open the Add New ICA Connection Wizard. Click Next 
to proceed through the wizard.

3.	Log on to the computer running Citrix Presentation Server to use Acrobat 8.

To run Acrobat 8 by using the Citrix Web Interface from a client computer:

1.	On the computer you want to use to access Acrobat, point the Web browser to the Citrix 
Server Web portal (for example, http://editcitrix.corp.adobe.com).

2.	If you have not yet downloaded the Citrix Web Interface client on this computer, you will be 
prompted to download it. Follow the on-screen instructions to download and install this 
application.

3.	Log on to the Citrix Web Interface client.

4.	On the Web portal site, click the application icon for the Acrobat 8 application you want to run.

To access published Acrobat files by using the Citrix Program Neighborhood client:

1.	Run the installer file ica32.msi on the computer you want to use as the Citrix Program 
Neighborhood client.

2.	Following installation, double-click the Citrix Program Neighborhood icon on the computer 
desktop.

3.	On the File menu, click Custom Connections Settings.

4.	On the Connection tab, do the following:

	Verify that the Network Protocol Connection is set to HTTP/HTTPS.

	Verify that the Server Group is set to Primary.

	If you want to add an address list, click Add, and then follow the on-screen instructions.

	Click OK.

5.	On the computer desktop, double-click Add ICA Connection.

6.	Set the connection type to Local Area Network, and then click Next.
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7.	 On the next page, do the following:

	Type a description of the ICA connection.

	Verify that the Network Protocol is set to TCPIP/HTTP.

	Click the Server option and type the server name in the text box.

	Click Published Application.

	In the list, click the name of the Acrobat application you want to run.

	Click Next.

8.	Select a view for the published application, and then click Next.

9.	On the Encryption Level page, click Next.

10.	Type your user credentials, and then click Next.

11.	Verify that the Windows colors are set to Default, and then click Next.

12.	Click Finish.

6. Removing Acrobat 8
You must uninstall Acrobat 8 by using either Add or Remove Programs or Citrix Installation 
Manager on the computer running Citrix Presentation Server.

To remove Acrobat 8 using Add or Remove Programs:

1.	Click Start, click Control Panel, and then click Add or Remove Programs.

2. In the list, select Adobe Acrobat 8, and then click Change or Remove.

3.	Restart the server to ensure that all the appropriate files are removed.

7. Troubleshooting
7.1  Contacting Adobe Technical Support
If you need to contact Adobe Technical Support, please prepare answers to the following ques-
tions so that we can better assist you:

1.	Which version of the Citrix software are you using?

2.	Which version of the operating system is on the Citrix server? Which Service Pack (if any) has 
been applied to the operating system?

3.	Which version of the operating system is on the client computer? Which Service Pack (if any) 
has been applied to the operating system? Do these programs meet the environment require-
ments listed in “Tested environments” in this document?

4.	What is the problem statement (for example, “When I do X with Y, Z happens”)? If the prob-
lem produces an error message, what is the exact wording of the message?

5.	Which user profile is logged on to the server (for example, Administrator or Power User)? 
Does the problem occur when an Administrator profile is logged on to the server?

6.	Which user profile is logged on to the client computer (for example, Administrator or  
Power User)? Does the problem occur when an Administrator profile is logged on to the  
client computer?

7.	 Can you reproduce the problem when you test the problem on the server? If so, what steps 
reproduce the problem?

8.	What goal are you trying to achieve? Have you been able to achieve this goal in the past? If so, 
did anything change recently in your environment that might be related to the problem?

Note  Adobe developed a series of tests (test matrix) to validate deployment. Adobe Technical 
Support can assist with features and issues that occur in the tested environments. However, 
Technical Support may not be able to thoroughly verify or support issues that occur outside of the 
tested environments.
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7.2  Known restrictions for Citrix clients
	 Issue #1101277: If the Enable Advanced Printing Features check box is selected 
in the Adobe PDF Printer, printing to the Adobe PDF Printer will fail. Please 
clear this check box. To do this, in Control Panel, click Printers and Other 
Hardware, right-click Adobe PDF Printer, and then select Properties. On the 
Advanced tab, clear the Enable Advanced Printing Features check box.

	 Issue #0640825: Acrobat PDFMaker and Adobe PDF Printer do not currently 
check Citrix licensing restrictions. Even users who don’t have access to the 
Acrobat application may be able to use Acrobat PDFMaker and Adobe PDF 
Printer.

	 Issue #1451407: The Acrobat 8 graphical interface renders poorly when displayed 
using 8-bit resolution on a Citrix client.

TechNote #326511: (http://www.adobe.com/support/techdocs/326511.html): 
Acrobat closes when a user right-clicks inside the main window. This applies to 
Acrobat and Reader versions 7 and 8 running on Citrix Presentation Server 4.0. 
To fix this problem, install the Hotfix Rollup Pack PSE400W2K3R03 for Citrix 
Presentation Server 4.0, Citrix Access Essentials 1.0 and 1.5 for Windows Server 
2003. For more information on this series of fixes, refer to the Citrix Systems KB 
article CTX111419 at http://support.citrix.com/article/CTX111419.
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